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EditLive! 9 End User Help Home

Welcome to the End User Help for EditLive! 9.



Copying and Pasting Content

Overview

Any content contained within an instance of EditLive! can be copied and then pasted at a different location in the editor. This includes content such as text,
images and tables. You can also copy content from other external sources, such as Microsoft Word, and paste this content into EditLive!.

Copy and Paste Methods

There are 4 basic methods for copying and pasting content into EditLive!:
Keyboard Shortcuts

Toolbar Buttons

Menu Items

L]
L]
L]
® Context Menu

To copy any content from EditLive!, all you need to do is first drag the cursor over the content while holding the mouse button. Then, use one of the
methods listed below to copy this content.

To paste content, click the cursor in the desired location in the EditLive! editor, then choose one of the following methods to paste this content.

The toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁ?)\istrator removing this functionality. For more information, see your Systems Administrator.

Keyboard Shortcuts

Any content in EditLive! can be copied by dragging the cursor over the desired items and simultaneously pressing the CTRL and C keys. You can then
click anywhere in EditLive! and simultaneously press the CTRL and V keys to paste this content into the editor.

If you've copied content from a source other than EditLive! (e.g. a webpage), you can still paste this content into your instance of EditLive! by clicking in the
desired location and pressing CTRL + V.

Toolbar Buttons

The EditLive! toolbar provides the following buttons for copying and pasting:

« 2 copy
. I_:']Paste
Menu ltems

The copy and paste menu items are located under the Edit menu.
The Edit menu features 3 copy-paste actions:

« 2 copy

L I__l-"l Paste
® Paste Special...

Paste Special... allows users to specify how content is copied into the EditLive! instance. This dialog is the same as the dialog used for Copy from
Microsoft Word. For more information on this dialog and what each option means, see the Copy from Microsoft Word section of this help article.

Context Menu
The context menu is displayed by clicking the right mouse button. By using the context menu, you can easily copy and paste content to and from EditLive!.
The context menu features the following copy and paste items:

e ==l copy

® -_.!1 Paste

When pasting using the context menu, the content will be pasted at current location of the cursor when the right mouse button is pressed, not the last
locgtion where you clicked in the EditLive! content.

Copying and Pasting Content from Microsoft Word
EditLive! allows you to copy content from Microsoft Word and choose exactly how this content is copied into your HTML document displayed in EditLive!.

To paste content copied from Microsoft Word, any of the 4 above mentioned pasting methods can be used.



Upon pasting content from Microsoft Word, EditLive! automatically detects that the content's origin is Microsoft Word and will display the following dialog:

Paste As:

Plain Text
HClean HTML

Skyled HTML (Inline)
Styled HTML (Embedded)
Resulk

Inserts the contents of the Clipboard in HTML Format
withaut skyvle infarmation,

(0]4 ’ Cancel ]

This dialog also appears for the Paste Special... option noted above for copying and pasting from Menu Items.

Note: This dialog may not appear when pasting content from Microsoft Word into your instance of EditLive!. This would be due to your Systems
Administrator removing this functionality. For more information, see your Systems Administrator.

This Paste Special dialog allows you to choose one of four different pasting options:

Note: Your Systems Administrator may have removed some of the options below, or defined a default action for Paste Special.... For more information, see
your Systems Administrator.

® Plain Text

Selecting the Plain Text option will strip out any style information or HTML formatting from the content, leaving only the text.

Example
If the following text was copied from Microsoft Word:

Ephox EditLive!

then the following content would be pasted into the EditLive! instance:

Ephox EditLive!

® Clean HTML

This option will paste copied content into EditLive! with no additional style information. This means style information such as text color will be
removed, while standard HTML formatting such as bold or italic will be preserved.

Example
If the following text was copied from Microsoft Word:

Ephox EditLive!

then the following content would be pasted into the EditLive! instance:
Ephox EditLive!

® Styled HTML (Inline)



This option allows all text copied to retain it's style information when pasted into EditLive!. The style information is embedded in a HTML <span> tag
surrounding the text.

Example
If the following text was copied from Microsoft Word:

Ephox EditLive!

then the following HTML content would be pasted into the EditLive! instance:

<p style=" font-size: 12.0pt; nmargin-right: Ocm font-famly: 'Tinmes New Roman'; margi n-bottom .0001pt;
margi n-top: Ocm margin-left: Ocm "><span style=" font-size: 16.0pt; color: red;"><b>Ephox EditLive!</b><
/ span></ p>

® Styled HTML (Embedded)

This option allows all text copied to retain it's style information when pasted into EditLive!. The style information is embedded in the EditLive! HTML
Document's <head><style> tag as a CSS class. The text is embedded in a HTML span tag referencing this CSS class.

Example
If the following text was copied from Microsoft Word:

Ephox EditLive!

then the following HTML content would be pasted into the EditLive! instance:

<head>

<span type="text/css">
p. MsoNor nal  {

}

mar gi n-top: 0cm

mar gi n-bottom .0001pt;
margin-left: Ocm

margin-right: Ocm

font-size: 12.0pt;

font-famly: "Times New Ronan";

</ span>
</ head>

<p><span style=" font-size: 16.0pt; color: red;"><b>Ephox EditLive!</b></span></p>



Hyperlinks

® Inserting Hyperlinks
® Broken Hyperlink Report
® Automatic Hyperlinks



Inserting Hyperlinks

Overview

Users can easily insert hyperlinks to a variety of content from a range of locations with-in their EditLive! content.

Displaying the Hyperlink Insertion Dialog
There are 3 basic methods for launching the hyperlink insertion dialog:

® Keyboard Shortcuts
® Toolbar Buttons
®* Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fufdtionality. For more information, see your Systems Administrator.

Keyboard Shortcuts

You can launch the Hyperlink Insertion dialog by simultaneously pressing CTRL + K.

Toolbar Buttons

The -ff“ toolbar button opens the Hyperlink Insertion dialog.

Menu Items

The Ef’ Insert Hyperlink... menu item located under the Insert menu.

Using the Hyperlink Dialog

The Hyperlink Insertion dialog has 4 distinct options for creating a hyperlink. These options are depicted in the following sections.

However, 3 fields are always editable in each section:

® Text to display - Text that will appear in the HTML as a hyperlink.
® Screen Tip - Text that will appear when a user hovers over the hyperlink in the resultant HTML.
® Address - URL the hyperlink will load.

Current Document Link



800 Insert Hyperlink

Text to display:

aj iEpthHomE || SetTitle.. |

Existing File or http://www.ephox.com/products/ Target frame:
Web Page D(-:u-l;rl:ﬁ:tnt http:/www.ephox.com/support/ [Mone] M
Email Web Links
Address
Places in
Document
Style: | Link =)

Address: | httpi/iwww.ephox.com

| Cancel | E—QK—J

From the list appearing in the middle of the dialog, you can choose to insert any hyperlink that has already been specified in your current HTML document
appearing in EditLive!.

The Target Frame properties depicts how the item specified in the hyperlink will display to the user:

None - Defaults to Same Frame (as mentioned below)

Same Frame - The hyperlink will open the linked document, replacing the current section containing this hyperlink.

Whole Page - When clicking this hyperlink, the entire contents of the browser window will be replaced by the linked document.
New Window - A new browser instance will be opened, containing the linked document.

Parent Frame - The hyperlink will open the linked document in the section wrapped around the section containing the hyperlink.

External Web Links



__Insert Hyperlink

Existing File or
Web Page

\i@

Email
Address

E.

Places in
Document

Text to display:
Ephox Home [ Set Title...
How To Update This List Target frame:
Current | e ohox Web sit [None]
Document | | EPDO% Web site

Ephox Documentation

Web Links | |Ephox Releases

Style: Link ™

Address: | httpi//support.ephox.com/

Cancel ]

When choosing this option, a list of possible hyperlinks specified by your Systems Administrator will appear in the center of the dialog.

Email Address

Lok |



800 Insert Hyperlink

Text to display:

@ iEphax Home | | SetTitle.. |

E-rnail Address:

Existing File or
Web Page

izales@ephnx.mm |

‘_@ ?u bject:

Email | |

@ Predefined e-mail addresses;

Places in
Document

Style: | Link =]

Address: | mailto:sales@ephox.com |

| Cancel | E—Dl‘—i

A hyperlink can be created that points to an email address. When a user clicks this hyperlink, their default email application will load. An email draft will
open in the user's email application with several values already assigned. These values automatically appearing in the email draft can be configured by
using the following fields in the Tiny hyperlink dialog:

® Email Address - The email address to appear in the To field for the draft email.
® Subject - The message to appear in the Subject field for the draft email

* Predefined email addresses - The list of predefined email addresses is supplied by your Systems Administrator. Clicking on one of these items
will automatically populate the Email Address field

Places in Document

10



800 Insert Hyperlink

Text to display:
' Oj |EditLive! | [ setile. |
Existing File or Select a place in this document:
Web Page EditLive! - Works Like a Rich Text Editor Should
Email
Address
Places in
Document
Style: | Link =]
Address: |#EditLi~.fE! -Works Like a Rich Text Editor Should |
| Cancel | E—DK—J
[ "

Automatically populates with heading tags and predefined bookmarks in the content. Selecting from this list creates internal hyperlinks to points with-in the
document, rather than hyperlinks to completely different documents.

Creating a Hyperlink
There are two methods for creating a hyperlink:

® Highlight the text you wish to become a hyperlink. Launch the hyperlink dialog using one of the three methods mentioned above.
® Launch the hyperlink dialog. Write the text you wish to appear as the hyperlink in the Text to display field at the top of the dialog.

11



Broken Hyperlink Report

Overview

The Broken Hyperlink Report functionality inspects all hyperlinks in the document, verifying the links actually point to a valid page.

The_Broken Hyperlink Report is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
indtance of EditLive!.

Displaying the Broken Hyperlink Report
The Broken Hyperlink Report is enabled via the Tools menu

. & Broken Hyperlink Report

The Broken Hyperlink Report toolbar button may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fungtionality. For more information, see your Systems Administrator.

Using the Broken Hyperlink Report

Launching the Broken Hyperlink Report will display the following dialog:

800 Broken Hyperlink Report
Address Walid

L http:/Aveen.ephox.com v

http://badlink =

Invalid hyperlinks found; 1

| lgnore Selected Hyperlink | | Cancel | E Ok, ]

-—

Double-clicking the address for a link will allow you to edit the address. Pressing enter or clicking on another link will cause the report to re-check the link.
Valid links will display a green tick while invalid links will display a red cross.

To ignore specific links, tick the checkbox to the left of the listed addresses. Click the Ignore Selected button to remove the links from the report.

12



Automatic Hyperlinks

Overview

The Automatic Hyperlink functionality automatically converts user-typed text containing a URL into a valid, clickable web hyperlink. Currently, Automatic
Hyperlink supports conversion on the following types of links:

http

https

file and FTP URLs

www URLSs without a protocol
email address URLs

Automatic Hyperlinking is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
in@ce of EditLivel.

Using Automatic Hyperlinking

To use Automatic Hyperlink, type text that begins with http://, https://, www., and email addresses into the document. After you press space, tab, or enter
immediately following this text, EditLive! will convert the text into a link. If you don't want the text to be a clickable hyperlink, simply press Ctrl+Z (or
alternatively, choose Undo from the Edit menu) after the link conversation has occured. This will undo the conversion of the text into a hyperlink but will
not undo your typing.

13



Window View Mode

Overview
When appearing on screen, EditLive! will be embedded in a webpage as a fixed size.

The Window View mode of the editor allows the editor to appear in a separate, resizeable window.

Launching the Window View Mode
There are 2 basic methods for launching EditLive! in the Window View mode:

® Toolbar Buttons
* Menu Items

The toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁ?histrator removing this functionality. For more information, see your Systems Administrator.

Toolbar Button
The EditLive! toolbar provides the following buttons for launching Window View mode:

A
e ¥ Window View

Menu Item

n
The ®  Window View item is located under the View menu.

Switching Between the WebPage and Window View
After launching the Window View, there are two separate options for returning to the webpage view:

® Close the Window View
® Click the Restore EditLive to the Browser button now appearing in the webpage.

14



Viewing content with different Page Widths

Overview

The Page Width allows the content in the editor to be displayed restricted to the specified page width for common devices.

Selecting the Page Width to display
There are 2 basic methods for selecting the Page Width to display content in EditLive!:

® Toolbar Button
® Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬁt})nality. For more information, see your Systems Administrator.

Toolbar Button

The EditLive! toolbar provides the following button for selecting Page Widths:

o [+ Window View

Menu Item

The L Page Width item is located under the View menu.

Choosing Page Width

Both Toolbar button and Menu item display a drop down menu of common display widths for Smartphone, Tablet and Monitor as well as Sizing to fit the
editor and a Custom width.

e 7

Smartphone Portrait

Smartphone Landscape

Tablet Portrait

Tablet Landscape

— Wanitor

[l

Widescreen Monitor

[

v & Sizeto Fit

Custom...

Preset Sizes
Choosing Smartphone Landscape will display the editor content, restricted to 480 pixels, the width of a Smartphone in Landscape.

15



. File Edit “iew Insert Format Tools TrackChanges Table Help

BY oo LFE@O0OE- Q0 & BB BB o 2
— ﬁcvl.-.v

— i
— F i—
— i—

I
1
Il
[l
Il
[l
Il

Heading 2 ~ | Arial ~2em~* B I U

EditLive! - Works Like a Rich Text Editor
Should

Eaitiivel is the nich
fext eaitor that
Wworks fike a moh
fext edifor showd
No reformatting. No
stress. Mo kidding.

Copy and

paste content
seamlessly, no
matter where your
content comes
from: Microsoft
Word, Excel or any
web site.

Image editing is a breeze with EditLive!'s built in image editor.

Aumid maickalae CAitl unl inclidas ot af the oo canahilitine coeh ae small

Preview Design Code
Size to Fit

Choosing Size to Fit displays the content of the editor at the width of the editor on the screen.

Custom Width

To display the editor content for a custom width, choose Custom... from the Page Width drop down. A dialog is displayed to enter a custom width in pixels.

® O O Page Width

width: || | px

| =

| Cancel
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Template Browser

Overview

The Template Browser functionality allows users to insert templates into any document they are editing withEditLive!. These templates are defined by the
Systems Administrator and could be as simple as a statement that needs to be added to the end of a document or as complex as an entire HTML layout.

The_Template Browser is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
indtance of EditLive!.

Displaying the Template Browser

The Template Browser can be opened via the Insert Template... item in the Insert menu.

The Template Browser menu item may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuiﬁtbnality. For more information, see your Systems Administrator.

Using the Template Browser

Launching the Template Browser will display the following dialog on the right hand side of your EditLive! instance:

® 0 Template Browser

b [ Layouts

e Wik

» [l Blog

b [ Formatting

| Close | sert

The categories displayed in this dialog may be different, depending on the configuration of your instance of EditLive!.

Clicking on the "+" symbol next to a folder will open that category. Alternatively, you can double click on the name of the category. After opening the
category, the dialog will look similar to the following:

17



@ MO Template Browser

» [ Layouts

> Gl wiki

» GllBlog

¥ [ Formatting
Lu_.ﬂlrnpartant Mote
g Tip
g Info Box
Lﬂﬂ Quaotation {left)
Lu_.ﬂ Quotation {right)
i) Image with Caption
Eﬂ Question/Answer

I'|_:|

| Close | S

The templates available to insert into your document are denoted by the LJ icon. The steps to insert a template are as follows:
® As the template will be inserted at the position of the caret in the document, you need to choose where you want the template to be inserted and
click in that position. This will not close the Template Browser.

® Once the position has been determined, choose the template you would like to insert. To insert the template into the document, simply double
click on it. Alternatively, you can select on the template and then press the Insert button.

Closing the Template Browser

The Template Browser can be closed in three ways. Two of these are on the dialog itself. However, you can also close the dialog by navigating to the
Insert menu and then choosing Hide Template Browser.

18



Collaboration

® Tracking Changes
® Commenting

19



Tracking Changes

Overview

EditLive! provides controls and rendering to allow you to easily review changes made to your rich content. The changes include content inserted, deleted
and modified by yourself and any other users who have edited the rich content.

TrcEg}ilchanges is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your instance of
EdjtLjve!.
The_toolbar, menu and context menu items described below are the standard items packaged with EditLive!. Any of the items listed below may be missing

fr our instance of the editor or contain different values than depicted in the screen captures. This would be due to your Systems Administrator
removing this functionality. For more information, see your Systems Administrator.

How Track Changes Works
When editing content normally in EditLive!, the content will appear in the editor as it will appear when published.
Example

The following screenshot shows EditLive! with the content 'Default document content'. An extra string in bold and italic has been added (‘extra string
added").

Ss File Edit ‘View Insert Format Tools TrackChanges Table Help

R ¥ = S HOELe s = o~ 2 - 4"
Mormal Paragraph ~ Arial ~13pxv B I U = =

il
B~
1
-
[

1

I
[}
Il
|
4
i
4

Default document content extra string added|

Preview Design Code

This content would appear as follows if saved as a . ht Ml webpage.
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File  Edit  Miew  Fawaorites  Tools  Help

@Back @ B @ ?x/,,lj pSearch *Favnrites @

Address | € Ciiresting2.html v EJ G Lnks ¥

Default document content exitrg string added

@ Done i My Computer

When editing content with track changes enabled, changes made will render in a different color. This allows you to easily identify which changes have
been made to your content.

Example

The following screenshot shows EditLive! with the content 'Default document content'. Track Changes is then enabled in the editor and an extra string in
bold and italic is added (‘extra string added").

%% File Edit View Insert Format Tools TrackChanges Table Help

¥ MBI 00 EOE-QeLRETEEHT -2

I
i
il
(il
1
[l
I

— L—
— ' i— v
— - p—

Normal Paragraph ~ Arial ~13px~ B I U

| Default document content extra string added|

Praview Design Coda

This content would appear as follows if saved as a . ht M webpage. The blue coloring is only used in EditLive! to help identify what changes have
occurred.
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3 C:Mesting2. html - Microsoft Internet Explorer

File  Edit  Miew  Fawaorites  Tools  Help #’
ur ) . »

(@9 Eack @ Ia @ @ /O Search * Favatites @

Address |7 C:\testing2. htr w Go  Links **

Default document content exitrg string added

@ Done a My Computer

The track changes functionality for EditLive! uses unique color rendering for each user of your system to display any content the user has created, deleted
or modified.

s File Edit View Insert Format Tools TrackChanges Table Help

R A o0 FEOE-QFRPEEEEEH W 2,

Mormal Paragraph ~ Arial 13 B I U =

il
il
B
L
e
4

— i
— " I— v
— - j—

Black text represents the original document with no track changes functionality applied

This paragraph is also part of the original decument.
Shrikethrough text in red has been deleted [or erased) by user 1 in the second line of content

This text has been created by user 2

The text ‘(or erased) has been entered by user 2 on the fourth line of content]

Preview | Design | Code

Content by 'user 1' has been rendered blue, while content by 'user 2' has been rendered red.
You can hover over specific changes to view:
® Which user made the change.

® What type of change occurred.
® What time the change occurred.
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» File Edit “iew Insert Format Tools TrackChangss Table Help

R ¥ = S HO=E-Q @ F Sl A A A
,éc'l;.'

(1l
il
il
[l
Il
[l
Il

— L—
— ¥ i— ¥
— i—

Mormal Paragraph ~ Arial ~13px» B I U

| New Content

Ephox User, August 8 2013 2:44 PM:
- Inserted Text

Preview Design Code

Displaying content created by 'Ephox User'.

EditLive! provides easy to use controls for reviewing these individual changes and deciding which changes should remain and which changes should be
undone.

Enabling/Disabling Track Changes
When EditLive! first loads, the track changes functionality will either be enabled or disabled based on settings specified by your Systems Administrator.
You can however enable/disable the track changes functionality manually using one of the following 3 methods:

® Menu ltem
® Toolbar Button
® Keyboard Shortcut

Menu Item

The % Enable Track Changes/Disable Track Changes menu item toggles enabling or disabling track changes. This menu item is located under the Tra
ck Changes menu.

Toolbar Button
The % toolbar button toggles enabling or disabling track changes.

Keyboard Shortcut

The track changes functionality can be toggled on and off by simultaneously pressing CTRL + SHIFT + E.

Setting the Current Username

With track changes enabled, all changes you make in the content are logged against your defined user name.

23



Your user name is defined in one of the following ways:

1. Your Systems Administrator has already configured EditLive! to automatically load your user name.
2. When track changes is first enabled, you will be prompted to enter your user name.

If you want to manually change your username at any point in time, you can use the Set Current User... menu item located under the Track Changes men
u.
Accepting/Rejecting Tracked Changes

Any tracked changes to the contents of EditLive! can be accepted or rejected.

Accepting Changes

Accepting a change means the selected change is retained in the content and no longer displayed as a change (i.e. the content is no longer rendered in a
unique color and hovering over the content no longer displays change information).

Example

The following screenshot depicts a line of content in EditLive! with the text new text added inserted in the middle.

S File Edit View Insert Format Tools TrackChanges Table Help

BY¥ oo PEOE-QG&0E BH e 2"
_ &l Ta~

— 1
— % i— v
— - p—

I
1l
Il
(i
Il
Il
Il

Normal Paragraph ~ Arial *13pxv B I U

| Default document new text added content|

Preview Design Code

Accepting this change would cause the text new text added to be merged with the document.
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R AV o0 EOE-QeIEEHTEERRED

— 1
— % i— v
— - p—

Mormal Paragraph = Arial *13px» B I U

Default document new text added content

Preview Design Code

Example

The following screenshot depicts a line of content in EditLive! with the text document content deleted from the end.
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oe File Edit View Insert Format Tools TrackChanges Table Help
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| Default decument content]

Prewview Dresign Code

Accepting this change would cause the text document content to be removed from the document.
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Once you have selected a desired change, you can accept the change using one of the following methods:

® Menu Item
® Toolbar Button

Menu Item
The ['ﬁ Accept menu item will accept the currently selected change. This menu item is located under the Track Changes menu.
Toolbar Button

The @ toolbar button will accept the currently selected change.

To accept all changes in your EditLive! content, use the Accept All Changes menu item located under the Track Changes menu.
Rejecting Changes
Rejecting a change means the selected change is removed from the content. Rejecting a change is equivalent to undoing the specific change.

Example

The following screenshot depicts a line of content in EditLive! with the text new text added inserted in the middle.
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Rejecting this change would cause the text new text added to be removed from the document.
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Example

The following screenshot depicts a line of content in EditLive! with the text document content deleted from the end.
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Rejecting this change would cause the text document content to be retained in the document.
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Once you have selected a desired change, you can reject the change using one of the following methods:

® Menu Item
® Toolbar Button

Menu Item
The @ Reject menu item will reject the currently selected change. This menu item is located under the Track Changes menu.
Toolbar Button

The @ toolbar button will reject the currently selected change.

To reject all changes in your EditLive! content, use the Reject All Changes menu item located under the Track Changes menu.

Selecting Changes
Specific changes can be selected (in order to accept or reject the change) by using the following methods:

® Clicking in the Desired Change
® Menu Items
® Toolbar Button

Clicking in the Desired Change

Clicking in a change will allow you to accept or reject this change. Once clicking in a change, you'll notice the accept and reject toolbar buttons and menu
items because available for use.

Menu Items

The @ Previous Change menu item will select the previous change in your content.
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The @ Next Change menu item will select the next change in your content.

Toolbar Buttons
The @ toolbar button will select the previous change in your content.

The @ toolbar button will select the next change in your content.

Reviewing Changes

The Review Changes... menu item (located under the Track Changes menu) provides a method for moving between each change in the document. Once
a change is selected, you can use the dialog provided to accept or reject the change.
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Commenting

Overview

The Commenting functionality allows users to both add comments to selections of text in a document and read comments that other users have written
within a document.

Ccc:{_nﬂenting is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your instance of
EdjtLjve!.

Adding a New Comment to Text With No Prior Comments

If the text that you want to comment on does not have any previous comments added to it, you will need to:

® Select all of the text you would like the comment to appear on
® Navigate to the Add Comment... menu item in the Track Changes menu or right-click and choose Add Comment..

The Add Comment... menu items may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fu{&t})nality. For more information, see your Systems Administrator.

This will display the Commenting popup next to the selected text, as follows:

Add Comment... X

Mo previous comments on this text,

ﬁ | Comment

This popup will be displayed until one of the following actions occurs:
® You add a comment and then move the mouse outside the popup
® You press the close button
® You click the mouse outside the popup, for instance, on the text in the document or on a menu item
Once a comment has been added, the commented text will be given a background color that matches the Track Changes color of the first user who

commented. This color can also be seen on the popup above as the background color of the user icon next to the comment text area. As in Track
Changes, this background color will not be rendered outside EditLive!.

Viewing Existing Comments

As noted above, any text that has been commented on will be rendered with a background color. To view these comments, simply mouseover this text.
After approximately one second, the Commenting popup will appear, as seen below.
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This text should have b comment.

Add Comment... X

ﬁ Brett at 11:03 AM on August 6, 2013 Remove
This is the first comment.

ﬁ Kristin at 04 Al on August 8, 2013 Remove
This is the second comment.

ﬁ Add a comment here... S

This popup will disappear when your mouse leaves both the commented text and the popup itself.

Adding a Comment to an Existing Conversation

When the popup above appears after you have moused over an existing comment, you can add a comment to the conversation by clicking in the textarea
with the text "Add a comment here..." Once you have clicked in this textarea, the dialog will be displayed until one of the actions described above occurs.
Comments added here will be applied to the exact section of text that has previously been commented on.

You can also comment on text that has already been commented on by selecting the text and using either the menu item or the right click menu. However,
there are some limitations to how the comment will be applied.

® |f you have selected only a portion of the commented text, your comment will be applied to the entire piece of text.
® [f you have selected a portion of the commented text with additional text around it, all existing comments and your comment will be applied to the
entire piece of text plus the extra selection.

Removing Individual Comments

It is easy to remove comments from any text in the document. Simply bring up the Commenting popup and click the Remove button to the right of the
comment you would like to delete. If you remove the first comment on a piece of text, the background color will be changed to the color of the author who
is now the first commenter on the text. If you remove all comments on a piece of text, its background color will be removed and the popup will no longer
appear when mousing over the text.

If you remove a comment accidentally, you can undo the action and return the conversation to its previous state.

Removing All Comments

Sometimes you may want to remove all of the comments in a document, for instance, if you are publishing a document to the web. All you need to do in
this case is navigate to the Remove All Comments menu item. Clicking on this item will instantly strip all comments and remove all highlighting from the
document.

Regardless of whether all comments in a document are removed, they will not be highlighted in your document outside of EditLive!.

The_ Remove All Comments menu item may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fufationality. For more information, see your Systems Administrator.

If you remove all comments accidentally, you can undo the action and return the document to its previous state.
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Working with Styles

Applying Sections to Content
Applying Styles to Content
Copying Style Information
Removing Style Information
Editing List Properties
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Applying Sections to Content

Overview

EditLive! provides extensive support for content sections, including HTML 5 Semantic tags. As a user you can create and remove sections, and even
create sections within other sections. EditLive! can help you to apply styles to a section, set the width of a section, or wrap text around floating sections.

This topic explains how to achieve the following:

Creating an empty section

Creating a section around existing text
Creating nested sections

Removing Sections

Section Properties

Floating Sections

Resizing Sections

To apply a style to a section, see the Applying Predefined Styles section of the Applying Styles article.

Creating an empty section

Creating an empty section can be done anywhere; even inside another Section. There are 2 basic methods for an inserting an empty section in EditLive!:

® Toolbar Button
® Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuuﬁt}bnality. For more information, see your Systems Administrator.

Toolbar Button

The EditLive! toolbar provides the following button for selecting Page Widths:

. @ Create Section

Menu Item

The @ Create Section item is located under the Insert menu.

Choosing a Semantic Tag
Both the Toolbar button and Menu item display a drop down menu containing the following elements.

=
* ="Blockquote

e &l piv

® Section
® |I=| Header
® ___ Footer

4 @Article
. @Aside

° Nav

Figure

® FigCaption

Some elements may not be available as they may be dependent on other elements or restricted in their use. For example, FigCaption is only available for
insdrtion in a Figure.

Creating a section around existing text

Sections can be created around existing text in much the same way as empty sections. Sections can be created on entire paragraphs or a selected
portion within a paragraph.

Example
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Select a portion of text in the middle of a paragraph:
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This is & paragraph| of text.

Creating a section will split the paragraph around the selection and create a section in the middle:

% File Edit View Insert Format Tools TrackChanges Table Help
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mparagraphl o [aee]
of text.

The type of section inserted will be indicated by text in the top corner of the section. In this example an Aside has been inserted.

Creating nested sections
EditLive! supports not only creating sections in paragraphs but also within existing sections.
Example

Highlight the middle paragraph of a section:

e Fil= Edit Wiew Insert Format Tools TrackChanges Table Help

¥ B AV 900 FEOE-QeIFLEEERR W 27"
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This is a paragraph of text.

[This is the second paragraph of text
;‘this is the third paragraph of text.

Creating a new section will not alter the outer section, instead nested a new section inside. Notice that the paragraph spacing has been removed to avoid
unnecessary spacing:
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Removing Sections

Use the Remove Section command, located on the Insert menu or the Context Manu to remove a section. Only the section types available from the
current cursor position will be available.

Example

With the cursor positioned in the text for the nested Aside section, the options enabled are the enclosing Section and Article sections.

e File Edit ‘iew Insert Format Tools TrackChanges Table Help
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Selecting Aside will remove the Aside section, leaving the other two sections in place and merging the paragraph into the enclosing section.
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With the cursor within the second paragraph, selecting Article from the Remove Section list will remove the outer Article section, leaving only the Section
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Th|s is a paragraph of text.
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this is the third paragraph of text.

Section Properties

EditLive! allows basic editing of section attributes. Right click on a section and choose Section Properties... to show the Section Properties dialog:

e 00 Article Properties
Layout
Alignment; | Default (] specify width:
*) In pixels
In percent

Style: [ Article %
General
I

| cancel | [—GK—]

Alignment - Float sections left or right

Specify width - Checking this box allows the width of the section, using either pixel or percentage units, to be set.
Style - CSS Style to be applied to the section type (if configured)

ID - Set the section identifier attribute
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Floating Sections

Floating sections are often used for page layout, and allow text to flow around the section. EditLive! supports creating floated sections using the alignment
option of the Section Properties dialog described above.

Example

Start with a single section as shown below:

%% File Edit ‘iew Insert Format Tools TrackChanges Table Help

¥ B AV oo EOE-QOeIsJFEEEERERE 2
Mormal Paragraph = Arial vi3pxy B I U E E E E~EvE = e~ I~

This is a paragraph of text.

this is the third paragraph of text.

Use the Section Properties dialog to align the section left:

e 00 Aside Properties
Layout
Alignment;  Default (] specify width:

=
=]
i
e
]
o
-
=

Style: | Aside L)
General
D
| cancel | [ oK ]
[ |

This brings the third paragraph up next to the second paragraph:
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This is a paragraph of text.
This is the second paragraphof text [2=i3etpis is the third paragraph of text.

Continuing to type in the third paragraph will flow down to the line below the second paragraph:
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This is a paragraph of text.

This is the second paragraph of text [22i2elipyis is the third paragraph of text. This is still the third

paragraph but with additional text in it. This demonstrates the wrapping around content that is in a section that is
floated.

If the second paragraph (inside the section) is then extended to two lines, the third paragraph layout will change to flow around it
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This is a paragraph of text.

e
V

:This is the second paragraph of text. With another line ‘:'this is the third paragraph of text. This is still the third

___________________________________________________________ ‘paragraph but with additional text in it. This
demonstrates the wrapping around content that is in a section that is floated |

EditLive! will update the page layout as you type in or resize the floated section. For best results, always specify a width for floating sections.

Resizing Sections

Sections can be resized either via the properties dialog or by holding the mouse cursor over the edge of a section (much like Images and Tables). Only
the width of a section can be changed, the height of a section is determined by the content within it.
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Applying Styles to Content

Overview

EditLive! provides an extensive variety of styles you can apply to your content. As a user you can apply different fonts, colors and sizes to your content.
EditLive! also allows you to choose the alignment on the page for specific content, as well as applying font formatting such as underlines.

This topic explains how to achieve the following:

Applying Bold, Italic or Underline Formatting to Text
Applying Alignment Formatting to Content

Applying Different Colors to Text

Applying Font-Face or Font Size Changes to Text
Applying Predefined Styles

The_toolbar, menu and context menu items described below are the standard items packaged with EditLivel. Any of the items listed below may be missing
fr our instance of the editor or contain different values than depicted in the screen captures. This would be due to your Systems Administrator
removing this functionality. For more information, see your Systems Administrator.

Applying Bold, Italic or Underline Formatting to Text
There are 3 basic methods for applying bold, italic or underline formatting to text:
® Keyboard Shortcuts

® Toolbar Buttons
* Menu Items

Keyboard Shortcuts
® Bold - Press Ctrl and B

® |[talics - Press Ctrl and |
® Underline - Press Ctrl and U

Toolbar Buttons

The EditLive! toolbar provides the following buttons for applying bold, italic and underline formatting to text:

. B Bold

. I Italic
. u Underline
Menu ltems
The bold, italic and underline formatting commands are located under the Format menu:

o B Bold

° I Italic
d uUnderIine

Applying Bold, Italic or Underline Formatting
Bold, Italic or Underline formatting can be applied in one of two ways
® Select the desired text (by holding down the left mouse button and moving the mouse over the desired text). With the text selected, specify bold,
italic or underline (or any combination of the three) by using any of the above mentioned methods.

® Move the cursor to the position in your content where you want to create formatted content. Select bold, italic or underline (or any combination of
the three) using any of the above mentioned methods. Begin typing your text to use the selected format.

Applying Alignment Formatting to Content
EditLive! provides 3 different forms of content alignment:
® Align Left - Content will be aligned to the left side of the page

® Align Center - Content items will be rendered in the middle of the page
® Align Right - Content will be aligned to the right side of the page
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There are 3 basic methods for applying alignment to content:

® Keyboard Shortcuts
® Toolbar Buttons
® Menu Items

Keyboard Shortcuts

® Align Left - Press Ctrl and L
® Align Center - Press Ctrl and E
® Align Right - Press Ctrl and R

Toolbar Buttons

The EditLive! toolbar provides the following buttons for applying alignment to content:

¢ = Align Left
Alight Center
Align Right

Menu Items

The alignment commands are located under the Format menu:

® = Align Left
Alight Center
e = Align Right

Applying Alignment to Content
Alignment of content can be applied in one of two ways
® Select the desired text (by holding down the left mouse button and moving the mouse over the desired text). With the text selected, specify the
desired alignment type by using any of the above mentioned methods.
® Move the cursor to the position in your content where you want to create formatted content. Select the desired alignment type by using any of the
above mentioned methods. Begin typing your text to use the selected alignment.
Applying Different Colors to Text
EditLive! allows you to change both the foreground and the highlight (or background) color of text.

There are 2 basic methods for changing the foreground or highlight color of text:

® Toolbar Buttons
® Menu Items

Toolbar Buttons

The EditLive! toolbar provides the following buttons for changing the color of text:

« e Highlight Color
o 08 Text Color

For either of these buttons, EditLive! provides 4 different methods for selecting the desired color:

Default Colors

Clicking either of the toolbar buttons specified above will display a list of default colors. Clicking the desired color to apply this color to selected text
or to begin writing text in this color.

Swatches

Click either of the toolbar buttons specified above. Click the More Colors... text. Click the Swatches tab at the top of the dialog. This dialog screen
allows you to select a color from a list of hundreds of colors.

Menu Iltems

The menu items for adding color to text are located under the Format menu:
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o e Highlight Color
o L Text Color

Selecting either of these menu items will then display a list of default colors. Select any color from this list to then apply this color to selected text or to
begin writing text in this color.

Applying Font-Face or Font Size Changes to Text
EditLive! allows you to change the font-face or the font size of text
There are 2 basic methods for changing the font face or size for text:

® Toolbar Combo Boxes
® Menu Items

Toolbar Combo Boxes
The EditLive! toolbar provides the following combo box for applying a new font face:
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Copy and paste content seamlessly, no matter
where your content comes from: Microsoft Word,
Excel or any web site.

Image editing is a breeze with EditLive!'s built in
image editor.

Avoid mistakes. EditLive! includes out of the box
capabilities such as spell check as you type,

a thesaurus and hyperlink checking. And you get
all of this without the need to license, install or
configure any third party software.

Track changes and commenting in EditLive! make collaboration with online documents just like that within
Microsoft Word. Speed up the revision process and collaboration amongst all your authors and reviewers.

Create great content with your CSS. EditLive! works with your site's CSS5. Authors can combine your style

Preview Design Coda

The EditLive! toolbar provides the following combo box for applying a new font size:
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Create great content with your CSS. EditLive! works with your site's CS5. Authors can combine your style

Preview Design Code

Menu Items

The menu items to apply a font-face or font-size can be located under the Format menu:

®* Font
® Size

Selecting these menu items will display a list of the available font faces or sizes, respectively.

Applying Font Face or Size Changes to Content
Font faces or styles can be applied in one of two ways
® Select the desired text (by holding down the left mouse button and moving the mouse over the desired text). With the text selected, specify the
desired font face or size by using any of the above mentioned methods.
® Move the cursor to the position in your content where you want to create formatted content. Select the desired font face and/or size by using any
of the above mentioned methods. Begin typing your text to use the selected alignment.

Applying Predefined Styles

Your Systems Administrator will have defined a list of predefined styles available for generating text with. These predefined styles will use a combination of
all the above mentioned styles. For example, one style may render text in bold, with right alignment, in the color red.

There are 2 basic methods for applying a new predefined style:

® Toolbar Combo Boxes
® Menu Items

Toolbar Combo Boxes

The EditLive! toolbar provides the following combo box for applying a new predefined style:
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Prewview Design Code

Menu ltems
The menu item to apply a predefined style can be located under the Format menu:
® Style

Selecting this menu items will display a list of the available predefined styles.

Applying Predefined Styles to Content
Predefined styles can be applied in one of two ways
® Select the desired text (by holding down the left mouse button and moving the mouse over the desired text). With the text selected, specify the
desired predefined style by using any of the above mentioned methods.

® Move the cursor to the position in your content where you want to create formatted content. Select the desired predefined style by using any of
the above mentioned methods. Begin typing your text to use the selected style.
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Copying Style Information

Overview

When a specific style is created for text appearing in EditLive!, this same style information can be copied and applied to any other text appearing in the
editor. Style refers to attributes of text such as color, size and font.

Methods for Copying Style Information

There are 3 basic methods for copying style information:

® Keyboard Shortcut
® Toolbar Button
®* Menu Item

Before using any of the methods listed below, you must first select the text in EditLive! which contains the style you wish to copy.
The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
funﬁ'fﬂbnality. For more information, see your Systems Administrator.

Keyboard Shortcut
Press the CTRL, SHIFT and C keys simultaneously to copy the selected style.

Toolbar Button

: g .
The toolbar button copies the style from the currently selected text.

Menu Item

' 4
The Format Painter menu item is located under the Format menu.

Applying Style Information
Copying and applying style information involves 3 steps:

1. Click text in EditLive! that has the desired style.

2. Select one of the three style copying methods described above.

3. Select the text you wish to apply this style to.
Select the text you wish to apply this style to by holding the mouse down and highlighting a word, sentence or paragraph. Upon letting go of the
mouse button, the style information will be copied to the selected text
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Removing Style Information

Overview

For any style specified for text appearing in EditLive!, this style information can be easily removed.Style refers to attributes of text such as color, size and
font.

Some style attributes may be locked through a default style. The default style information for paragraphs is specified by the Systems Administrator during
indtallation and configuration of EditLive!. For more information on the default paragraph style information, see your Systems Administrator.

Removing Style Information

Removing style information involves 2 steps:

1. Select text in EditLive! where you'd like to remove the current style information.

Select the text you wish to remove style from by holding the mouse down and highlighting the specified text.

2. Trigger the Remove Styles Information Method
There are 3 basic methods for triggering the Removes Styles Information Method:

® Keyboard Shortcut
® Toolbar Button
® Menu Item

The toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adfi])\istrator removing this functionality. For more information, see your Systems Administrator.

Keyboard Shortcuts

Simultaneously press the CTRL and Space keys.

Toolbar Buttons

. '.é Remove Formatting

Menu ltems

The é Remove Style Information menu item is located under the Format menu.

Upon invoking this method, the style information will be removed from the specified text.
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Editing List Properties

Overview

For any list appearing in EditLive!, you can use the List Properties dialog to change the display of a list.

Displaying the List Properties Dialog
There are 2 basic methods for editing a list's properties.

® Menu Item
® Context Menu

In order to launch the List Properties dialog, you must first click in a list.
Menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this functionality.
Fadf imore information, see your Systems Administrator.

Menu Item

The List Properties... menu item is located under the Format menu.

Context Menu

The context menu is displayed by clicking the right mouse button. The option List Properties... can be chosen from the context menu when editing a list.

Changing a List's Properties

Using the List Properties dialog you can specify either an unordered list or ordered list.
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- NaNs List Properties

List type
Default ¢ © "
. — 0 — . —
nordered . a -
Default ! A a2
2 — B — _
Crdered 3 C
|, —— j, ——
. — i, ——
n — i, ———
Style: | UnorderedList % |
| Cancel | [ oK

Unordered Lists

Unordered lists have no logical ordering. Each list item is displayed with the same icon. To choose your desired list icon, click one of the bullet icon types
then press OK.

Ordered List

An ordered list has a logical ordering.To choose your desired list icon, click one of the alpha-numeric icon types then press OK.
For ordered lists the starting number and selected element number can be altered using the following fields.

® Start at field - defines which number the list begins at.
® Value of Selected Element field - defines the number displayed for the list item selected when this dialog was displayed.

Example
For an instance of EditLive!, the following list and list properties are defined:

A list with 5 items was selected.

The icon type '1. 2. 3." was selected.

Start at value: 5.

List item 3 was selected when dialog displayed.
Value of Selected Element: 10.

The following list would appear:

5. list item
6. list item
10. list item
11. list item
12. list item
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Images and Multimedia

Inserting Mathematical Equations
Image Insertion

Inserting Multimedia

Editing Image Properties

Editing Images

Drag and Drop
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Inserting Mathematical Equations

Overview

The WebEQ equation editor allows you to insert mathematical characters into your content. The WebEQ equation editor is a separate window displayed by
EditLive!. You can create your mathematical equations here then insert these equations into your EditLive! content.

The WebEQ equation editor is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
indtance of EditLive!.

Using the Equation Editor

To use the WebEQ equation editor requires 3 steps:

1. Open the WebEQ equation editor window
2. Create your equation
3. Insert the equation into your EditLive! content

Opening the Equation Editor Window
The equation editor window can be opened by clicking the Nz icon on the EditLive! toolbar or from one of the EditLive! menus.

Thestocation of the Nz icon depends on your System Administrator's installation of EditLive!. For more information, see your Systems Administrator.

The equation editor will appear as shown in the image below:

800 Eguation Editor
File Edit Insert Properties Preferences Help
DD‘{E, 00 |@ o] | £0sin ,fﬁv G | — | Fx| <> ec| V3 [ Alallb
Style: | inherited | R v BR] 2
MathML ancestry  <math> @ <mrow> @ <mfrac>
| OK | | Cancel |

Creating an Equation

]
For more information on how to use the WebEQ Equation Editor, click the —J help button.

Inserting the Equation into EditLive!

To insert an equation into your EditLive! content, click the OK button. To edit equations stored in your content, double click the equation to re-open the Web
EQ Equation Editor window.
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Image Insertion

Overview

EditLive! allows you to insert images from various locations.

Inserting Local Images

You can use the Local Image... menu item from the Insert menu to directly insert a local image into EditLive!.

Displaying the Image Insertion Dialog

There are 2 basic methods for displaying EditLive!'s image insertion dialog:

® Toolbar Buttons
® Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬁt})nality. For more information, see your Systems Administrator.

Toolbar Buttons

The G toolbar button opens the Image Insertion dialog.

Menu Items

The G Insert Image... menu item located under the Insert menu.

Using the Image Insertion Dialog

The Image Insertion Dialog allows image insertion from 3 different locations:

® Image Library
® |ocal Image
® Image Browser

Not all of the following Image Insertion Dialog components may exist in your instance of EditLive!. This would be due to your Systems Administrator not

imﬁé)nenting the following functionality. For more information, see your Systems Administrator.

Image Library
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Insert Image

Image Library

™

Local Image

Image Description

Business team Photo of a business team meeting

MNote taking Photo of taking notes in a meeting

Businessman Photo of a businessman

Bird Photo of a bird in a tree )

Forest Photo of a forest Please zel.ectan Image
Mountain Photo of a mountain toinsert

Penguin Yellow eyed penguin

Laptop Laptop and mouse

Globe Globe icon

Font Fonticon

Lightbulb Lightbulb icon
Address: | |
Alternative text: | |

| cancel | F—OK—J

This dialog allows you to choose a list of images created by your Systems Administrator. For the example above, there are 11 images specified with the
identifying names like Business team, Note taking and Businessman.

After selecting any image, you can see the location of the image in the text field at the bottom of the page.

Once an image has been selected, it will automatically appear for previewing in the Please select an image to insert pane.

Local Image
®0Oa Insert Image
Click Browse to select an image file: :
@ | Browse.. |
Image Library
- .
sephox
] -~
- e
Local Image
Address: | file:/Users/brett/Desktop/ephox_logo.png |
Alternative text: | |

| Cancel | E—GK—J
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This dialog allows you to insert an image from your local machine or network. For the example above, the image specified is at /Users/brett/Desktop
/ephox_log.png.

Clicking the Browse button will launch the standard file browsing dialog used by your machine. You can use this dialog to search your local machine or
network for the desired image.

Once selecting an image, the image will appear in the Please select an image to insert pane.

Depending on how EditLive! has been implemented by your Systems Administrator, local images may also be uploaded to a server location to allow any
user to view the image. For more information see your Systems Administrator.
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Inserting Multimedia

Overview

EditLive! allows you to insert rich media from social media and cloud-based media services along with your own video and audio into your content.

The_permitted types of multimedia you can insert into your content will depend on settings specified by your Systems Administrator.

Displaying the Media Insertion Dialog

There are 2 basic methods for displaying EditLive!'s media insertion dialog:

® Toolbar Buttons
® Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬁt})nality. For more information, see your Systems Administrator.

Toolbar Buttons

The o toolbar button opens the Media Insertion dialog.

Menu Items

The 0 Insert Media... menu item located under the Insert menu.

Using the Media Insertion Dialog

The Media Insertion Dialog allows you to insert media in 4 ways:

Media Service
Embedded Code
Hosted Video
Hosted Audio

Media Service

Media Services allows the inclusion of content from YouTube, SlideShare, Instagram, Google Maps and over 200 other social media services.
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1 W S I— Ne—— Insert Media

I @ Media Services

URL: v
(h Embed Code (] Specify size:
i : v LEED aspec io
% Video Width: Keep aspect rat
Height:

4']) Audio

Alignment; | Default

Preview:

URL - Location of the Media Service content

Specify Size - Checking this box allows the width and height for the media to be adjusted.

Width - Width (in pixels) of the media

Height - Height (in pixels) of the media

Keep Aspect Ratio - Checking this box ensures the width-to-height ratio will always remain the same.
Alignment - Location of the embedded multimedia on the page.

Preview - A preview of the content supplied by the service.

If the oEmbed content is a video a placeholder image thumbnail will be displayed as specified by the Media Service provider.

Embedded Code

Embedded Code allows the insertion of HTML code, for example and iFrame containing a website.
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Paste the embed code fragment below.

[ Cancel ]

Video

Video allows the insertion of hosted video content into the editor.
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e 00

Insert Media

@ Media Services

(b Embed Code

% Video

4'}) Audio

Sources:

URL: | (Tyee :j @@
Poster | |
width: | | Height: * | |

-

Alignment: | Default %

Controls Enabled: [ |
Fallback HTML:

| cancel | [ oK ]

® URL - Location of the Video file
®* Type - Type of the video file.
There are 3 video types supported

* MP4
* OGG
* WEBM

Additional versions of the video can be inserted using the ﬂ button. Versions can be removed using the = button beside the desired version.

® Poster - Location of the image to display for this video before being played in the browser.

If no image is specified, the
Width - Width (in pixels) of the video

Height - Height (in pixels) of the video
Alignment - Location of the video in the page
Controls Enabled - Checking this box will display playback controls for the video in the browser.
Fallback HTML - HTML of the content to display if the browser doesn't support the HTML 5 video tag.

Audio

. placeholder image will

Audio allows the insertion of hosted audio content into the editor.

appear in the editor
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800 Insert Media

@ Media Services
Sources:

<[» Embed coce URL: * | | [ype i @@
% Video
q?]} Audio

d

Alignment; | Default 3

Fallback HTML:

| Cancel | [ oK ]

® URL - Location of the audio file
®* Type - Type of the audio file.
There are 3 audio types supported

* WAV

* MP3
* OGG

Additional versions of the audio can be inserted using the ﬂ button. Versions can be removed using the = button beside the desired version.

® Alignment - Location of the audio in the page
® Fallback HTML - HTML of the content to display if the browser doesn't support the HTML 5 audio tag.

e —
Audio content will be displayed with the placeholder image within the editor.

Editing a Media Properties

After inserting multimedia, you can adjust the media’s properties by double-clicking the placeholder. This will display the Media Insertion dialog for the
particular media type with all the values set for the media.
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Editing Image Properties

Overview

You can easily adjust the properties of any image appearing in EditLive!. Adjusting image properties is performed by using the Image Properties Dialog.

Displaying the Image Properties Dialog
Once you have an image selected in EditLive!, there are 2 basic methods for displaying the Image Properties Dialog:

® Double Click
® Context Menu

Double Click

Double click a selected image to launch the Image Properties Dialog.

Context Menu
The context menu is displayed by clicking the right mouse button. By using the context menu, you can easily edit the properties for a selected image.
The context menu features the following item to display the Image Properties Dialog:

® Image Properties...

Using the Image Properties Dialog
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8 o0 Image Properties

Image URL: | content/editorcontentfimages/ephox.jpg

Layout

—_— —

Alignment: | Right +| Horizontal spacing: |

——e

Border thickness: | Vertical spacing:

Style: | Image =+
Size
(] Specify size:
Width: 350 v Keep aspect ratio
Height: 228

Alternative Representation

Alternative text: | Stylized Ephox Logo

Title:;
| Cancel | [ oK ]
® Image URL - Location of the selected image.
® Alignment - Location of the image in the page
® Border Thickness - Thickness (in pixels) of the border surrounding the image.
® Horizontal Spacing - Spacing (in pixels) between the horizontal borders of the image and the actual image itself.
® Vertical Spacing - Spacing (in pixels) between the vertical borders of the image and the actual image itself.
® Style - CSS Style to be applied to the image (if configured)
® Specify Size - Checking this box allows the width and height for the image to be adjusted.
® Width - Width (in pixels) of the image
® Height - Height (in pixels) of the image
® Keep Aspect Ratio - Checking this box ensures the width-to-height ratio will always remain the same. For example, insert an image with a height

25% the size of the width. If the user types 100 for the width, the height will automatically populate as 25.
Alternative Text - Text to appear if the image doesn't load.
Title - Text to appear when the user hovers their mouse over the image.
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Editing Images

Overview

EditLive! allows you to easily manipulate images using effects such as rotation, reflection and image cropping.

Image Editing is an optional functionality of EditLivel. Check with your Systems Administrator first to ensure this functionality exists in your instance of
Edjtljve!.

Dynamically Resizing Images

Selecting an image will cause the image border to flash and nine black boxes to appear. These boxes represent the horizontal, vertical and diagonal
vertices.

You click and hold your mouse button to drag these vertices and increase the size of the image. By default, image resizing using the corner resize
handlers maintains the image aspect ratio. To resize an image without adhering to it's aspect ratio, hold the SHIFT key while resizing.

Using the Image Editor

Loading the Image Editor

Images can be edited via the Image Editing Toolbar. This toolbar will appear on screen any time you click on an image in the editor.
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%% File Edit View Insert Format Tools TrackChanges Table Help
AR oo FEOB-QLEE |2~ .
Image ~ Arial vi3pxr B I U EE E E~v=~E = fee~ Iz~

o 2 2 A 8 B A @l crop

Prewview Design Code

Rotating Images Clockwise

Ll
The =i icon will rotate the currently selected icon in a clockwise direction.

Before After

Rotating Images Counter-Clockwise

i
The &= jcon will rotate the currently selected icon in a counter-clockwise direction.
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T

Before After

Flipping Images Vertically

=1
The ™4 icon will flip the image so that it's upside down

37

Before After

Flipping Images Horizontally

The 4k icon will flip the image so it appears back-to-front (i.e. the left side and right side of the image are switched).

83>

Before After

Applying Reflection to Images

The E icon will apply a reflection effect to images

A&

Before After

65



Applying Drop-Shadows to Images

The icon will apply a drop-shadow to images.

Al

Before After

Applying Rounded Corners to Images

The Fi icon will apply rounded corners to images

Before After

Cropping Images

The icon will display a crop mask over the currenﬁselected image. This mask can be dragged over the image or resized using the 9 resize handlers

appearing around the edge of the mask. Clicking the icon again will replace the current image with the area selected in the crop mask.

a2 2 A EH B A Bcrop
|| |

Before the Crop icon is selected
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Apply

Crop icon selected, crop mask displayed

2 2h =9 4 H @ A @&crop

Crop applied
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Drag and Drop

EditLive supports dragging and dropping of images into the editor from web pages and filesystem browsers such as Windows Explorer.

Supported Platforms

Drag and drop support is only available on specific platforms as outlined below. Other platforms and scenarios may work but are not officially supported.

Dragging from web pages

® Firefox and Chrome on Windows
® Firefox and Chrome on Ubuntu and Linux Mint

Dragging from filesystem browser

® Firefox, Chrome and IE 9-11 on Windows
® Firefox and Chrome on Ubuntu and Linux Mint

Image drag and drop was introduced in EditLive 9.0.3
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Proofreading Tools

Using the Spell Checker

Enabling/Disabling Spellcheck-As-You-Type
Using the Thesaurus

Using Word Count

Using the Find Dialog
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Using the Spell Checker

Overview

EditLive! allows users to check the spelling found in their content. Users can manually edit or choose a variety of alternatives for incorrectly spelt terms.

Spell Checker Methods

There are 4 basic methods for spell checking in EditLive!:
Keyboard Shortcuts
Toolbar Buttons

Menu Items

L]
L]
L]
® Context Menu

The_toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁ?)mistrator removing this functionality. For more information, see your Systems Administrator.

Keyboard Shortcuts

Press F7 on your keyboard to open the Spell Check Dialog.
Toolbar Buttons
ABC
The EditLive! toolbar provides the « button for displaying the Spell Check Dialog:
Menu Items
ABC
The " Spelling... item is located under the Tools menu.

Context Menu

The context menu allows users to change the spelling of the currently selected word.
-&ﬁh"‘

Ephox

Expo

Euphory

Fe

Phlox

Phone

lgnore All
Add to Dictionary

) Undo A

"o

M Cop i

[3 Paste e}

Select »>
Synonyms »>
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® The first 5 options displayed in the context menu are the estimated 5 closest matches to the incorrectly spelt word.
® Ignore All - See the corresponding button in the Spell Check Dialog.
® Add to Dictionary - See the corresponding button in the Spell Check Dialog .

Using the Spell Check Dialog

8 o0 Check Spelling
Mot in dictionary:
| lgnore |

Epho -
Change to: |Ignn—rEAII|
Ephox | Add |
Suggestions: | Change |
Ephox B
Expo | Changeall |
Euphorny

Fé S
Phlos S
Phone | Cancel |

Not in Dictionary - This is the current word EditLive!'s spell checking believes is spelt incorrectly

Change to - You can manually enter or edit the word appearing here to match your desired spelling.

Suggestions - A list of suggested correctly spelt words to replace the currently incorrect spelling. Clicking on any of these suggested words will
display the word in the Change to textfield. This way you can edit the suggested word as you see fit.

Ignore - Ignores the current instance of the incorrectly spelt word and moves to the next mispelt word.

Ignore All - Ignores all instances of this incorrectly spelt word in the contents of EditLive!

Add - This function is used to add the word EditLive! believes is incorrectly spelt to your dictionary. After a word is added to the dictionary
EditLive! will not identify the word as incorrectly spelt ever again.

New words added to the dictionary will only be applied to your user profile on your machine. Other users on your machine, or separate machines,
will still see words you've added to the dictionary appear as incorrectly spelt text.

Change - Replace this instance of the word with the current contents of the Change to field

Change All - Replace all instances of this word in your EditLive! content with the current contents of the Change to field.

Undo - This will undo the last incorrectly spelt word you changed.

Cancel - Closes the dialog
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Enabling/Disabling Spellcheck-As-You-Type

Overview

EditLive! provides functionality that displays incorrectly spelt words as they are entered into the editor.

Methods for Enabling/Disabling Spellcheck-As-You-Type

There are 2 methods for enabling/disabling Spellcheck-As-You-Type:

® Toolbar Button
® Menu Item

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fu(&t})nality. For more information, see your Systems Administrator.

Toolbar Button
The EditLive! toolbar provides the R button for toggling Spellcheck-As-You-Type.
Menu Item

The s Check Spelling As You Type toggle menu item is located under the Tools menu.

Determining Incorrectly Spelt Words

When Spellcheck-As-You-Type is activated, incorrectly spelt words will appear with a red line underneath them.
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Using the Thesaurus

Overview

EditLive! allows users to compare words found in their content against a in-built thesaurus.

Tﬁ]esaurus is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your instance of
Edjtljve!.

Thesaurus Methods

There are 2 basic methods for referencing the thesaurus in EditLive!:

® Menu Items
® Context Menus

The_toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁhistrator removing this functionality. For more information, see your Systems Administrator.

Menu Items

The Thesaurus... item is located under the Tools menu.

Context Menu

The context menu allows users to change the currently selected word.

Fast
=) Undo A
M Cut A3y
Eg| Copy e
[, Paste e}
Select >

n

@) Add Comment...

Synonyms fast
hasty
Open Thesaurus...

The context menu displays several synonyms and a link to the Thesaurus Dialog.

Using the Thesaurus Dialog
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L.8.00, s IO SAUTS e ———— -
« IEI Search For: | Fast |Tkup
Fast Insert
fast ad). Insert

allegro, breakneck, dashing, expeditious, fast, fleet, galloping, hasty,
hurrying, light-footed, nimble, presto, quick, rapid, rushing, snappy,
speedy, swift

hasty adj. Insert

abrupt, breakneck, breathless, brisk, bustling, darting, dashing, fast,
feverish, fleet, flying, galloping, hasty, hurried, impatient, pelting, quick,
rapid, running, rushing, speedy, swift, urgent

| cancel |

The Search For text field allows you to enter any new word in order to display it's synonyms. Press the Lookup button to refresh the results.

Selecting a word in the list will display synonyms for that word. For example, selecting galloping in the dialog above will display the following
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8 00 Thesaurus I

IEI > Search For: |galloping | Lookup |

galloping nsert

fast ad). nsert
allegro, breakneck, dashing, expeditious, fast, fleet, galloping, hasty,
hurrying, light-footed, nimble, presto, guick, rapid, rushing, snappy,
speedy, swift

hasty adj. nsert
abrupt, breakneck, breathless, brisk, bustling, darting, dashing, fast,
feverish, fleet, flying, galloping, hasty, hurried, impatient, pelting, quick,
rapid, running, rushing, speedy, swift, urgent

running verb nsert
bounding, cantering, darting, dashing, galloping, hurrying, jogging, loping,
plunging, racing, running, rushing, scampering, scooting, scrambling,
scurrying, sprinting, tearing, trotting

speeding verb nsert
dashing, galloping, hurrying, rushing, speeding

|' Cancel |

[~
To return to the previous page of synonyms use the arrow buttons |E|

To insert the most appropriate word, press the Insert link beside the word. For example, to insert Speeding in the example above, select the Insert link
beside it.
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Using Word Count

Overview

EditLive! allows users to view how many words their current content contains.

The Word Count dialog displays how many words are contained in the current contents of EditLive!, not how many words are contained in any currently
selacted text.

Displaying Word Count

The Word Count menu item is located under the Tools menu.

ABC
e [113 word Count

The _toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁ?)mistrator removing this functionality. For more information, see your Systems Administrator.
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Using the Find Dialog

Overview

EditLive! allows users to search for specific text in their content.

Find Methods

There are 3 basic methods for finding specific text in EditLive!:

® Keyboard Shortcuts
® Toolbar Buttons
®* Menu Items

The toolbar, menu and context menu items described below may not appear in your instance of EditLive!. This would be due to your Systems
Adﬁ’lhistrator removing this functionality. For more information, see your Systems Administrator.

Keyboard Shortcuts

Press CTRL and F keys simultaneously to display the Find Dialog.
Toolbar Buttons

The EditLive! toolbar provides the “‘{a button for displaying the Find Dialog.
Menu Items

The & Find menu item is located under the Edit menu.
Using the Find Dialog

8 .00 Find

Find what: Ephox

Replace with:

[ | Match case

[ | Wholeword only

| Replace | | Replaceall | [ Find Mext ] | Cancel |

® Replace - Move to the next instance of the text found in the Find What field and replace it with the text found in the Replace With field.

® Replace All - Automatically move through the document replacing all instances of the text in Find What with the text found in the Replace What fie
Id.

® Find Next - Move to the next instance of the text found in the Find What field.

® Cancel - Closes the dialog.

®* Match Case - When checked, performing the Replace, Replace All or Find Next functions only moves to text that exactly matches the format of
the text found in the Find What field.

Example
If Find What contained the text Ephox, clicking Find Next would not move to the word ephox.

® Whole Word Only - Replace, Replace All or Find Next will only move to the text in Find What field is this text can be found as it would appear in a

sentence.
For example, if Find What contained the text Ephox, clicking Find Next would nat move to the text XXXEphoxXXX.
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file:///Users/brett/Desktop/enduserhelp/en/using_the_find_dialog.htm#finddialog

Accessibility Compliance

® Checking Accessibility Compliance
® Accessibility As You Type
® Table Accessibility
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Checking Accessibility Compliance

Overview

EditLive! comes packaged with a reporting tool allowing you to check your content across several worldwide HTML accessibility guidelines.

Displaying the Accessibility Report Tool

The Accessibility Report menu item is located under the Tools menu.

. @IAccessibility Report

The_Accessibility Report menu item may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuffdtionality. For more information, see your Systems Administrator.

Using the Accessibility Report Tool

800 Accessibility Report

Show error levels: [ﬂ Errors [ﬂ Warnings [ﬂ Manual Checks

Check guidelines: (™ wcaG Priority & M WCAG Priority AA (™ Section 508

Cuideling Section Summary
Sk Section 508 A A text equivalent for every non-text element shall ...
& |WCAGA  |1.11  |Provide atext equivalent for every non-text elemea. ..
5l WCAG A 122 Provide captions for audio content.
5l WCAG A 1.23 Provide an audio or text description as an alternat...
EL WCAGAA 124 Provide captions for audio content.
Section 508 C Web pages shall be designed so that all informati...
WCAG A 1.41 Ensure that information is not conveyed through ..
Section 508 D Ensure documents may be read without style she...
WCAGAA 125 Provide an audio or text description as an alternat...
Section 508 | Pages shall be designed to avoid causing the scre...

Reference: hitgu/fwww.w3.org/TR/201 2/MOTE-WCAG20-TECHS-20120103/H37.html

This non-text element is missing a text equivalent (e g. provided via "alt" or
"longdesc” attributes). Provide brief alternative text describing the information
conveyed by this element. Alternative text can often be in the element's
properties dialog,

Using the Accessibility Report tool, you can check your HTML content against the following guidelines:

® WCAG A - The W3C (World Wide Web Consortium) Web Content Accessibility Guideline. This guideline specifies that a web content developer m
ust specify these checkpoints.

® WCAG AA - The W3C (World Wide Web Consortium) Web Content Accessibility Guideline. This guideline specifies that a web content developer
should specify these checkpoints.

® Section 508 - Section 508 are web content accessibility guidelines specified as part of the US Rehabilitation Act.

For each guideline selected, the following items will be displayed:
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. I_i Errors - Errors depict HTML elements which require a precise change to ensure the content is accessible under the selected guideline.
Clicking on an Error in the Accessibility Report tool will move the cursor in EditLive! to the location of the HTML containing this error.

® =% Warnings - Warnings relate rather to the entire HTML document itself, where errors focus on a particular HTML element.
® Manual Checks - These are aesthetic based accessibility checks that can't be programmatically detected. As a user, you'll need to review your
content to ensure these accessibility guidelines are met.

Clicking on an Error, Warning or Manual Check will populate the Reference field with a hyperlink to this documented accessibility guideline. A summary
for the accessibility guideline the Error, Warning or Manual Check relates to will appear in the text area at the bottom of the Accessibility Report tool.
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Accessibility As You Type

Overview

EditLive! can display an icon over HTML elements which contain data that does not match Accessibility Compliance standards.

Accessibility-As-You-Type is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
in@ce of EditLivel.

Enabling/Disabling the Accessibility As You Type Display

The Accessibility-As-You-Type menu item is located under the Tools menu.

° @' Enable/Disable Accessibility As You Type

The_Accessibility-As-You-Type menu item may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuligtionality. For more information, see your Systems Administrator.

Using Accessibility As You Type

Accessibility As You Type displays an icon in the bottom lefthand corner of tables, images or sections (i.e. DIV elements) which break specific accessibility
standards.

e« Fle Edit VWiew Insert Format Tools TrackChanges Table Help

X AV moeFfEHOE QTGRS
Mormal Paragraph~ B I U e~ Iy~

— i
— % i— v
— - p—

I
1
Il
Il
Il
Il
Il

Accessibility Compliance Made Easy

EditLive! makes it easier for authors to create content that's compliant with accessibility guidelines like Section
508 in the USA or the W3C's Web Content Accessibility Guidelines.

The accessibility check as you type functionality within EditLive! detects errors with tables,
images and media.

A comprehensive accessibility report is also available from the 7oods menu in EditLivel.

For tables, EditLive! provides extra accessibility functionality, including options to convert
between relative and absolute units, a table accessibility inspector, and an

(l;—ka::essihility wizard. Both of these are on EditLive!'s inline table toolbar. Together these
tools enable users to make even the most complex data tables accessible.

This Week's Schedule

Time Day
Monday Tuesday Wednesday Thursday Friday
Morning Meetings Work Work Travel Work
Afternoon Available Work Meetings Meetings Work
Evening Tennis fixtures Dinner and movie |Available Travel Available {5.(

Preview Design

Code

Hovering over an Accessibility As You Type icon will display a tooltip detailing which aspects of the HTML element are in violation of accessibility

compliance. The errors and warnings detected are specified by your Systems Administrator.
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EditLive! makes it easier for authors to create content that's compliant with accessibility guidelines like Section
508 in the USA or the W3C's Web Content Accessibility Guidelines.

&

The accessibility check as you type functionality within EditLive! detects errors with tables,
images and media.

A comprehensive accessibility report is also available from the Toofs menu in EditLive!.

For tables, EditLive! provides extra accessibility functionality, including options to convert
between relative and absolute units, a table accessibility inspector, and an

Secoion 508) A text equivalent for every non-text element shall be provided.
| (WCAG &) Provide a text equivalent for every non-text element. |

This Week's Schedule

accessibility wizard. Both of these are on EditLive!'s inline table toolbar. Together these
tools enable users to make even the most complex data tables accessible.

Time

Day
Monday Tuesday Wednesday Thursday Friday
Marning Meetings Work Work Travel Work
Afternoon Available Work Meetings Meetings Work
Evening Tennis fixtures Dinner and movie |[Available Travel Available (';‘a,c

Preaview Design

Code

Errors are more severe accessibility issues are are represented by the (% icon.

E
Warnings are less critical issues or issues which may not be a problem depending on the current context. Warnings are represented by the {"f_J- icon.

82



Table Accessibility

Applying Accessibility Mappings
View Table Header Mappings

Clear Cell Headers

Convert Table Sizing to Percentages
Convert Table Sizing to Pixels
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Applying Accessibility Mappings

Overview

EditLive! provides a tool for applying accessibility mappings to table cells. For more information on how table accessibility mappings work, review the View
Table Header Mappings help article.

The_ Applying Accessibility Mappings is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists
in @r instance of EditLive!.

Using the Apply Accessibility Mappings Functionality

Applying accessibility mappings is a 4 step process.

The_toolbar buttons described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fufgtionality. For more information, see your Systems Administrator.

The screenshots depicted below have View Table Header Mappings switched on. This allows you to see the current accessibility status of each table cell
S0 yiou can apply the desired mappings.

Step 1: Select the cell you wish to become a header cell. This cell can already be a header cell.

%% File Edit View Insert Format Tools TrackChanges Table Help
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Cell B I UEEEE~E~EE & Iy
This Week's Schedule
Time Day N
Monday uesday ednesday hursday Friday L
Maorning Meetings ork ork ravel ork Ly
Afternoon vailable ork Meetings Meetings ork L
Ewvening ennis fixtures Dinner and movie™Available ravel vailable L

=t o 3 ¥R H Mm@ B BsetAsHeader G H

Preview Design Code

Step 2: Click the Set As Header button on the floating table toolbar. This will highlight the cell with a blue border.
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Time Day
Monday uesday ednesday hursday Friday
Moming Meetings ork ork ravel ork
Afterncon vailable ork Meetings Meetings ork
Evening ennis fixtures Dinner and movie™Available ravel vailable
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Preview | Design | Code

Step 3: Select the desired cell/cells you wish to become data cells. A single cell can be selected by clicking in it. Multiple cells can be selected by dragging
the mouse.
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Step 4: Click the Apply Header button. This will apply an ID attribute to the selected header cell and headers attributes to the selected data cells.
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View Table Header Mappings

Overview

View Header Mappings hides or displays whether a cell is a header cell, a data cell or neither.

View Header Mappings is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
indtance of EditLive!.

Enabling/Disabling View Table Header Mappings

There are 2 basic methods for toggling View Header Mappings:

® Floating Toolbar Buttons
®* Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fufdtionality. For more information, see your Systems Administrator.

Toolbar Buttons
The @ toolbar button on the floating table toolbar toggles hiding or displaying table header mappings.
Menu Iltems

The @ Show/Hide Table Header Mappings menu item located under the Table menu.

Using View Table Header Mappings

For the currently selected table, View Header Mappings displays an icon in each table cell depicting the accessible status of the cell.
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For each table cell the following icons indicate it's status
B Header Cell - cell defined as containing a heading

 H pata Cell - cell defined as containing data
e ¥ Error Cell - cell definition has not been defined
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Clear Cell Headers

Overview

Clear Cell Headers removes any headers attributes present on the currently selected table cells.
Enabling Clear Cell Headers
The Clear Cell Headers toolbar button is available on the floating toolbar displayed when selecting content in a table.

. ﬂ Clear Cell Headers

The_Clear Cell Headers toolbar button may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuuﬁﬂbnality. For more information, see your Systems Administrator.

Using Clear Cell Headers

Select the desired cells with header attributes and click the Clear Cell Header button. The Clear Cell Headers button will only be enabled when you have
selected a cell or cells that contain header attributes.

Using the View Table Header Mappings functionality you can easily view which table cells feature header attributes.
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Convert Table Sizing to Percentages

Overview

Convert Table Sizing to Percentages ensures all widths and heights specified for a table and it's cells are represented as percentages.

Convert Table Sizing to Percentages is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists
in mr instance of EditLive!.

Applying Percentage Sizing to a Table
There are 2 basic methods for applying Convert Table Sizing to Percentages:

® Floating Toolbar Buttons
®* Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fufdtionality. For more information, see your Systems Administrator.

Toolbar Buttons

The lsnﬂ toolbar button on the floating table toolbar changes all widths and heights in the current table to percentage values.

Menu Items

The lsn'ﬂ Use Relative Sizing for Table menu item located under the Table menu.
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Convert Table Sizing to Pixels

Overview

Convert Table Sizing to Pixels ensures all widths and heights specified for a table and it's cells are represented as pixels.

Convert Table Sizing to Pixels is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
in@ce of EditLivel.

Applying Pixel Sizing to a Table
There are 2 basic methods for applying Convert Table Sizing to Pixels:

® Floating Toolbar Buttons
®* Menu Items

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬂvﬂbnality. For more information, see your Systems Administrator.

Toolbar Buttons

@ ) ) ) ) )
The toolbar button on the floating table toolbar changes all widths and heights in the current table to pixel values.
Menu ltems

x
The l:g Use Pixel Sizing for Table menu item located under the Table menu.
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Using the Document Navigator

Overview

EditLive! features a Document Navigator to allow the easy selection of HTML elements appearing in your content.

Locating the Document Navigator

The Document Navigator will appear between the last row of toolbar buttons and the Design pane of EditLive!. The content you have currently selected
will be displayed in the document navigator with an orange background.

The_Document Navigator may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this functionality. For
m{r%'}information, see your Systems Administrator.

Using the Document Navigator
You can use the document navigator to select the current HTML element you're editing, or any surrounding HTML element.

For example, the screenshot below depicts the Document navigator if you were editing the contents of a list nested in a table cell.

S File Edit WView Insert Format Tools TrackChanges Table Help
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Table Row Cell UnorderedLlist Listltern Content

Hyperlink Checking
= 0 W m 2 & £ Set AsHeader BR @ H links.

Working Links | Eroken Links
» Ephox Home Phge e Microsoft Home Page
* Bing Search » Google Search

# Apple Home Page

Prewview Design Code

Row

If you wished to select the entire table row containing this content, selecting the text in the Document Navigator would perform the following
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Inserting HTML Comments

Overview
You can easily insert HTML comments into your content. HTML comments are not directly displayed to end users, but can be seen in the actual HTML.

Anyone viewing your content through a web browser will be able to view your HTML comments by selecting theView Source option in their browser.

Displaying the Comment Insertion Dialog

There are 2 basic methods for inserting comments into EditLive!:

® Toolbar Button
® Menu ltem

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬁt})nality. For more information, see your Systems Administrator.

Toolbar Button

The EditLive! toolbar provides the following button for inserting HTML comments:

1
o 2 Insert Comment...
Menu ltem
1
The <= Insert Comment... menu item is located under the Insert menu.

Using the Comment Insertion Dialog

Using the Insert Comment toolbar or menu item will display the following dialog:

e 00 Edit Tag...

M wrap text | Cancel | [ oK J

Type the text you wish to be hidden. Click OK when done.

HTML Comments will be displayed in the Design View of EditLive! as III placeholder icons. Double clicking one of these icons will reopen the dialog,
allowing you to edit your comment.
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Insert HTML Fragment

Overview

Many programs and systems provide you with the ability to export snippets of HTML containing rich content. If you have a selection of HTML you wish to
paste into EditLive!, there are two options available.

® Code View
® Insert HTML Fragment

Code View

Code view allows you to view the raw source of your HTML content. When looking at this, a power user can insert any HTML they like. This means that
when you are using an external site and would like to copy and paste HTML, you can do so directly into EditLive!.

Insert HTML Fragment

EditLive! includes a plugin which makes inserting HTML from varied sources even easier. This plugin, Insert HTML Fragment, makes it very easy to insert
HTML snippets into EditLive! without using code view.

Insert HTML Fragment is an optional functionality of EditLive!. Check with your Systems Administrator first to ensure this functionality exists in your
indtarice of EditLive!.

Displaying the Insert HTML Fragment Dialog

Insert HTML Fragment is enabled via either the Insert HTML Comment... item in the Insert menu or by the Iﬁ' button on the toolbar.

The_Insert HTML Fragment menu item may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fu{&t})nality. For more information, see your Systems Administrator.

Using Insert HTML Fragment

Launching Insert HTML Fragment will display a simple dialog with a single text area into which HTML can be pasted.

e 00 Insert HTML Fragment

| Cancel | [ Ok J

In order to make this process extremely easy, EditLive! will check the clipboard for HTML when the dialog is first opened and automatically add this text
directly to the text area. When the dialog is closed with the OK button, this HTML will be added to the existing document's source code.
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Showing Paragraph Markers

Overview
EditLive! can be toggled to display all of the hidden formatting currently applied to your HTML. This includes displaying information such as:

® Paragraph ends
® New line characters
® List item formatting

Methods for Enabling/Disabling Show Paragraph Markers
There are 2 methods for enabling/disabling Show Paragraph Markers:

® Toolbar Button
® Menu Item

The_toolbar and menu items described below may not appear in your instance of EditLive!. This would be due to your Systems Administrator removing this
fuﬁt})nality. For more information, see your Systems Administrator.

Toolbar Button
The EditLive! toolbar provides the 1' button for toggling Show Paragraph Markers
Menu Item

The 1' Paragraph Markers toggle menu item is located under the Tools menu.

Displaying Paragraph Markers
When Show Paragraph Markers is enabled, various new formatting will appear.

Example: The following images show content with a paragraph, a list and a table:

97



%% File Edit View Insert Format Tools TrackChanges Table Help

¥RV o0 EOE-QOSIFDEERRE 2"
= ﬁcvlﬁv

i— i
— v i— |v

Il
Il
I
[l
I

Marmal Paragraph = Arial 13~ B I U E =

Language Tools

EditLive! includes spell checking and thesaurus out of the box, without the need to use third party| services or
plug-ins.

# Spell check as you type highlights misspelled words and provides suggestions via the right click menu.
» Auto-correct will fix common mistakes, just try typing "teh"

# Synonyms are also available on the right click menu.

e A full thesaurus is available from the Toels menu.

e Add words to your personal dictionary or customize spelling for your whole organization

* Spell checking is available in 12 different languages. See the Internationalization demo to try it out.

Hyperlink Checking
The hyperlink checker checks all the links in your document and alerts you to any broken links.
Working Links | Broken Links
# Ephox Home Page e Microsoft Home Page
# Bing Search * Google Search

« Apple Home Page

Preview Design Code

EditLive! - Show Paragraph Markers Disabled
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Language Tools

EditLive! includes spell checking and thesaurus out of the box, without the need to use third party| services or
plug-ins.

Hyperlink Checking

The hyperlink checker checks all the links in your document and alerts you to any broken links.

Working Links | Broken Links

EditLive! - Show Paragraph Markers Enabled
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Frequently Asked Questions

Overview

This article lists several common questions about EditLive! along with detailed answers

Questions

A toolbar/menu item does not appear in EditLive! as this help file specifies.

My table has no border, but a border still appears on screen.

The insert symbol dialog doesn't contain my desired symbol.

I've inserted an image, but now | want to change it's size. How do | change the properties of an image I've already inserted.
How do | change the appearance of a list

How can | resize the editor?

Can | insert mathematical equations into my content?

A toolbar/menu item does not appear in EditLive! as this help file specifies.

Answer: This functionality has not been added to your editor instance. See your Systems Administrator to install the functionality.

My table has no border, but a border still appears on screen.

Answer: This dashed border is used as a guideline and will not appear in the actual HTML. Use the Hide Guidelines menu/toolbar item to enable or
disable this functionality.

The insert symbol dialog doesn't contain my desired symbol.

Answer: The items appearing in the insert symbols dialog are defined by your Systems Administrator. If your Systems Administrator is unwilling or unable
to add your desired symbol, you can copy the symbol from an external location and paste it directly into your content.

I've inserted an image, but now | want to change it's size. How do | change the properties of an image
I've already inserted.

Answer: For information on editing Image Properties, see the Editing Image Properties article.

How do | change the appearance of a list

Answer: For information on editing List properties, see the Editing List Properties article.

How can | resize the editor?

Answer: EditLive! for Java is set to appear as a default size by the Systems Administrator. You can, however, use the Window View functionality to view
the editor as a separate resizeable window. For more information, see the Window View Mode article.

Can | insert mathematical equations into my content?

Answer: Yes. EditLive! supports the use of an equation editor. Equations can be generated in this dialog and then entered into the content of EditLive!.
For more information, see the Equation Editing article.
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Toolbar Button and Menu Item List

Overview

This rich text editor features a wide variety of toolbar buttons and menu items. This page provides a quick reference for the functionality provided by each
of these toolbar buttons and menu items.

The toolbar and menu items described below may not appear in your instance of the editor. For more information, see your Systems Administrator.

Menu and Toolbar Items

File Commands

Menu or Tool Tip Text  Function Shortcut Image
New Create a new file. CTRL+N _-]
Open... Open an existing file on the local machine. CTRL+O Lﬁ
Save Save a file to the local machine. CTRL+S H
Save As.. Save a file to the local machine with a different name. ' CTRL+SHIFT+S -
Restore Autosave... Restore an autosaved document. - -

Import Word Document... ' Import a Word Document. - -

Print Print the contents of the editor. - I;:I
Edit Commands
Menu or Tool Tip Text = Function Shortcut | Image
Undo Undo the last action. CTRL+Z )
Redo Redo the last undone action.  CTRL+Y e
Cut Cut the selection. CTRL+X M
Copy Copy the selection. CTRL+C :-‘__]
Paste Paste. CTRL+V
e
Paste Special Paste using a specific filter. | - -
Select All Select all editor content. CTRL+A -
Find... Find text in the editor. CTRL+F “L
View Commands
Menu or Tool Tip Text Function Shortcut  Image
Design View View the document in Design mode (WYSIWYG mode). = - -
HTML View View the HTML source for the document. - -
Window View Display the editor in a separate window. - t‘
Document Navigator Show or hide the document navigator. - -
Show/Hide Paragraph Markers = Show or hide paragraph markers and editing grid lines. | - 1]
Page Width View the document within a set page width. - =+

Choices include

® Smartphone Portrait

® Smartphone Landscape
® Tablet Portrait

® Tablet Landscape
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Monitor

Widescreen Monitor
Size to Fit

Custom

Insert Commands

Menu or Tool Tip Text

Insert Hyperlink...

Remove Hyperlink

Bookmark...

Remove Bookmark

Insert Image...

Insert Media...

Insert Object...

Insert HTML Fragment...

Insert Template...

Create Section

Remove Section

Symbol...

Insert Horizontal Rule

Insert Date and Time...

Insert HTML Comment...

Edit Tag...

Function

Insert a hyperlink.

Remove a hyperlink.

Insert a bookmark.

Removes a bookmark.

Insert an image from the server image library.

Insert Media

Insert an embedded object or multimedia file.

Insert a Fragment of HTML.
View and Insert Templates

Create a section around the selected text.

Displays a menu of section types, including:
® BlockQuote
® Div

® Section

® Header

* Footer

® Article

® Aside

®* Nav

® Figure

® FigCaption

Remove a section.
Displays a menu of section types.

Insert a symbol.
Insert a horizontal line.
Insert a date and time.

Insert a HTML comment.

Edit a HTML comment, scripting tag or unknown custom tag.

Format Commands

Menu or Tool Tip Text

Bold

Italic

Underline

Align Left

Align Center

Align Right

Function

Bold.

Italic.

Underline.

Set left alignment.

Set center alignment.

Set right alignment.
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Ordered List

Unordered List

Decrease Indent

Increase Indent

Color

Highlight Color

Superscript

Subscript

Strikethrough

Left to Right Text

Right to Left Text

Remove Formatting

Format Painter

Text Formatting

Alignment and Indents

Insert an ordered list or change an unordered list to an ordered list.

Insert an unordered list or change an ordered list to an unordered list.

Decrease the paragraph or list indent.

Increase the paragraph or list indent.

The text color.

The text highlight color.

Superscript text.

Subscript text.

Strikethrough.

Set dir for the currently selected block elements to Itr
Set dir for the currently selected block elements to rtl
Remove formatting.

Copy selected formatting.

Popup menu of formatting commands, consisting of:

Bold

Italic
Underline
Superscript
Subscript
Strikethrough

Popup menu of Alignment and Indenting commands, consisting of:

® Align Left

® Align Center

® Align Right

® Decrease Indent
® Increase Indent

Tool Commands

Menu or Tool Tip Text

Spelling...

Enable/ Disable Check Spelling As You Type

Enable/Disable Auto Correct

Word Count...

Thesaurus...
Synonyms

Proofing Tools

Content Language

Function

Check spelling.

Perform a word count on the document.

Run the thesaurus.

Toggle the background spell checker.

Toggles the Auto Correct functionality on and off.

CTRL + SPACE

CTRL + SHIFT + C

Shortcut

F7

Display a list of synonyms for the currently selected word. = -

Popup menu of Proofing commands, consisting of: -

Spelling

Link Checking
Accessibility Report

Word Count

Disable Spell Checking as you type

Enable Accessibility as you type

Mark selected content as written in chosen language. -

Table Commands

Image
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Menu or Tool Tip Text

Insert Table...

Insert Row

Insert Column

Insert Row or Column...

Insert Cell

Delete Table

Delete Row

Delete Column

Delete Cell

Split Cell

Merge Cells

Show/Hide Gridlines

Fit to Content

Function

Insert a table.

Insert a row in the current table.

Insert a column in the current table.

Insert rows or columns in the table.
Insert a cell in a table.

Delete the current table

Delete a row from a table.

Delete a column from a table.

Delete a cell from a table.

Split a cell in a table.

Merge cells in a table.

Toggle table gridlines.

Automatically resize a column to fit its content.

Properties Commands

Menu or Tool Tip Text
Cell Properties...

Row Properties...
Column Properties...
Table Properties...

List Properties...

Object Properties...

Horizontal Line Properties...

Section Properties...

Function

Edit the current cell's properties.

Edit the selected row's properties.

Edit the selected column's properties.

Edit the current table's properties.

Edit the properties of a list.

Edit the properties of an embedded object.
Edit the properties of a horizontal line.

Edit the properties of a Section.

Help Commands

Menu or Tool Tip Text

Help...

About EditLivel...

Help

Function

Load editor help.

Display information about current editor version.

Shortcut

Shortcut

Image
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Image

Shortcut

Popup menu of help and debugging commands, consisting of: = -

®* Help
® About EditLive!
® Enable Debug Logging

Form Commands

Menu or Tool Tip Text
Insert Form

Insert Text Field

Insert Password Field
Insert Hidden Field
Insert File Upload Field

Insert Button Field

Function

Insert a form.

Insert a text field into a form.

Insert a password field into a form.
Insert a hidden field into a form.
Insert a file browsing field into a form.

Insert a button into a form.

Shortcut
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Insert Submit Field Insert a submit button into a form. - -
Insert Reset Field Insert a reset button into a form. - -

Insert Checkbox Field Insert a checkbox into a form. - -

Insert Radio Field Insert a radio-button into a form. - -
Insert TextArea Field Insert a text area into a form. - -
Insert Select Field Insert a selection / combobox into a form. - -
Insert Image Field Insert an image field into a form. - -
Form Properties... Display the Form Properties Dialog for a form. ' - -

Track Changes Commands

Menu or Tool Tip Text Function Shortcut Image
Enable Track Changes / Disable Track Changes = Toggle change tracking. CTRL + SHIFT + E %
Accept Change Accept selected change. - @»
Reject Change Reject selected change. - @-
Accept All Changes Accept all changes. - -
Reject All Changes Reject all changes. - -
Next Change Select next change. - @
Previous Change Select previous change. - @
Show Track Changes Dialog Show track changes dialog. | - -
Set Username... Set current user. - -

Image Editor Commands

Menu or Tool Tip Text = Function Shortcut | Image
Rotate Clockwise Rotate image clockwise. - Su
Rotate Counterclockwise = Rotate image counterclockwise. | - dr:
Flip Vertically Flip image vertically. - _q1
Flip Horizontally Flip image horizontally. - Al
Reflection Effect Apply reflection effect. - E
Drop Shadow Effect Apply drop-shadow effect. - E
Round Corners Effect Apply rounded-corners effect. - l,c.'j
Crop Crop image. - IE'-.!

Accessibility Commands
Menu or Tool Tip Text Function Shortcut Image
Enable / Disable Accessibility As You Type Toggle accessibility-as-you-type. - @
Accessibility Report... Perform an accessibility compliance check on the document | CTRL + F8 @l
Use Relative Sizing for Table Convert all widths and heights in a table to percentages - @
Use Pixel Sizing for Table Convert all widths and heights in a table to pixels - I@
Clear Cell Headers Clear table cell headers. - ﬂ
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Set As Header / Select Data Cells / Apply Header = Apply table cell headers .

Show / Hide Table Header Mappings

Link Checker

Menu or Tool Tip Text = Function Shortcut | Image

et

Broken Hyperlink Report | Check validity of hyperlinks in document. = - #

Commenting

Menu or Tool Tip Text Function

Add Comment... Open commenting popup to add or read comments on a selected area of text

Remove All Comments = Remove all comments in the document

Equation Editor Commands

Menu or Tool Tip Text = Function Shortcut | Image
Insert Equation Insert a mathematical equation. | - ,ﬂrf
Edit Equation... Edit a mathematical equation. | - -

Toolbar Combo Items

Submenu/Combo Box @ Function

Style List of styles available for use on the current selection.
Font List of fonts available for use on the current selection.
Size List of font sizes available for use on the current selection.
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Language and Text Direction

EditLive! has several tools for setting the language and text direction of content in the editor.

Text Direction

Text direction can be changed using using the " Left to Right Text" and " Right to Left Text" menu items. By default, these are in the Format menu. These
buttons change the text direction for the current paragraph only.

Content Language

The "Content Language" drop-down lets you specify the language for the selected text. This also sets the text direction for this text. Specifying the
language within the editor can assist users who use screen readers and search engines that index the site.

To remove the language, select the text and click the "Remove Language" item on the drop-down.
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